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Getting Started
Welcome to Learn Adobe Premiere Pro CC for Video Communication! We use a combi-

nation of text and video to help you learn the basics of video editing with Adobe 

Premiere Pro CC along with other skills that you will need to get your first job as 

a video editor. Adobe Premiere Pro CC is a powerful program for capturing foot-

age from a variety of devices and assembling it into professional-quality video with 

sophisticated transitions, special effects, and text. You can also use Premiere Pro to 

export your video to many popular formats that your viewers can watch on a wide 

range of screens, including desktop computers and mobile devices like phones and 

tablets.

About this product
Learn Adobe Premiere Pro CC for Video Communication was created by a team of 

expert instructors, writers, and editors with years of experience in helping begin-

ning learners get their start with the cool creative tools from Adobe Systems. Our 

aim is not only to teach you the basics of the art of video editing with Premiere Pro, 

but to give you an introduction to the associated skills (like design principles and 

project management) that you’ll need for your first job. 

We’ve built the training around the objectives for the Video Communication Using 

Adobe Premiere Pro CC (2015) Adobe Certified Associate Exam. If you master the 

topics covered in this book and video you’ll be in good shape to take the exam. But 

even if certification isn’t your goal, you’ll still find this training will give you an 

excellent foundation for your future work in video. To that end, we’ve structured 

the material in the order that makes most sense for beginning learners (as deter-

mined by experienced classroom teachers), rather than following the more arbitrary 

grouping of topics in the ACA Objectives.

To aid you in your quest, we’ve created a unique learning system that uses video 

and text in partnership. You’ll experience this partnership in action in the Web Edi-

tion, which lives on your Account page at peachpit.com. The Web Edition contains 

8 hours of video—the heart of the training—embedded in an online eBook that 

supports the video training and provides background material. The eBook mate-

rial is also available seperately for offline reading as a printed book or an eBook in 

a variety of formats. The Web Edition also includes hundreds of interactive review 

questions you can use to evaluate your progress. Purchase of the book in any format 
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entitles you to free access to the Web Edition (instructions for accessing it follow 

later in this section).

Most chapters provide step-by-step instructions for creating a specific project or 

learning a specific technique. Other chapters acquaint you with other skills and 

concepts that you’ll come to depend on as you use the software in your everyday 

work. Many chapters include several optional tasks that let you further explore the 

features you’ve already learned.

Each chapter opens with two lists of objectives. One list lays out the learning objec-

tives: the specific tasks you’ll learn in the chapter. The second list shows the ACA 

exam objectives that are covered in the chapter. A table at the end of the book 

guides you to coverage of all of the exam objectives in the book or video.

Most chapters provide step-by-step instructions for creating a specific project or 

learning a specific technique. Many chapters include several optional tasks that let 

you further explore the features you’ve already learned. Chapters 8 and 9 acquaint 

you with other skills and concepts that you’ll come to depend on as you use the 

software in your everyday work. Here is where you’ll find coverage of Domains 1 

and 2 of the ACA Objectives, which don’t specifically relate to features of Premiere 

Pro but are important components of the complete skill set which the ACA exam 

seeks to evaluate.

Conventions used in this book
This book uses several elements styled in ways to help you as you work through the 

exercises.

Text that you should enter appears in bold, such as:

In the Link field in the Property inspector, type https://helpx.adobe.com/ 

premiere-pro.html.

Links to videos that cover the topics in depth appear in the margins.

The ACA objectives covered in the chapters are called out in the margins beside the 

sections that address them.

Notes give additional information about a topic. The information they contain is 

not essential to accomplishing a task but provides a more in-depth understanding 

of the topic.

NotE  In time notation, the numbers after the last colon are frames.  
For video you read time as hours, minutes, seconds, and frames.

 Video 5.1 Working 
in the timeline

 ACA Objective 2.1
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operating system differences
In most cases, Premiere Pro CC works the same in both Windows and Mac OS X. 

Minor differences exist between the two versions, mostly due to platform-specific 

issues. Most of these are simply differences in keyboard shortcuts, how dialogs are 

displayed, and how buttons are named. In most cases, screen shots were made in 

the Mac OS version of Premiere Pro and may appear somewhat differently from 

your own screen.

Where specific commands differ, they are noted within the text. Windows com-

mands are listed first, followed by the Mac OS equivalent, such as Ctrl+C/Cmd+C. 

In general, the Windows Ctrl key is equivalent to the Command (or “Cmd”) key 

in Mac OS and the Windows Alt key is equivalent to the Option (or “Opt”) key in 

Mac OS.

As lessons proceed, instructions may be truncated or shortened to save space, with 

the assumption that you picked up the essential concepts earlier in the lesson. For 

example, at the beginning of a lesson you may be instructed to “press Ctrl+C/

Cmd+C.” Later, you may be told to “copy” text or a code element. These should be 

considered identical instructions.

If you find you have difficulties in any particular task, review earlier steps or exer-

cises in that lesson. In some cases if an exercise is based on concepts covered earlier, 

you will be referred back to the specific lesson.

installing the software
Before you begin using Learn Adobe Premiere Pro CC for Video Communication, make 

sure that your system is set up correctly and that you’ve installed the proper soft-

ware and hardware. This material is based on the original 2015 release of Adobe 

Premiere Pro CC (version 9.0) and is designed to cover the objectives of the Adobe 

Certified Associate Exam for that version of the software. 

The Adobe Premiere Pro CC software is not included with this book; it is avail-

able only with an Adobe Creative Cloud membership which you must purchase 

or it must be supplied by your school or other organization. In addition to Adobe 

Premiere Pro CC, some lessons in this book have steps that can be performed with 

Adobe Media Encoder and other Adobe applications. You must install these appli-

cations from Adobe Creative Cloud onto your computer. Follow the instructions 

provided at helpx.adobe.com/creative-cloud/help/download-install-app.html.

x Learn Adobe Premiere Pro CC for Video Communication
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ADobe CReAtive CLouD DeSktoP APP

In addition to Adobe Premiere Pro CC, this training also requires the Adobe 

 Creative Cloud desktop application, which provides a central location for manag-

ing the dozens of apps and services that are included in a Creative Cloud member-

ship. You can use the Creative Cloud desktop application to sync and share files, 

manage fonts, access libraries of stock photography and design assets, and show-

case and discover creative work in the design community.

The Creative Cloud desktop application is installed automatically when you down-

load your first Creative Cloud product. If you have Adobe Application Manager 

installed, it auto-updates to the Creative Cloud desktop application.

If the Creative Cloud desktop application is not installed on your computer, you 

can download it from the Download Creative Cloud page on the Adobe website 

(creative.adobe.com/products/creative-cloud) or the Adobe Creative Cloud desktop 

apps page (www.adobe.com/creativecloud/catalog/desktop.html). If you are using 

software on classroom machines, be sure to check with your instructor before mak-

ing any changes to the installed software or system configuration.

CheCking foR uPDAteS

Adobe periodically provides updates to software. You can easily obtain these 

updates through the Creative Cloud. If these updates include new features that 

affect the content of this training or the objectives of the ACA exam in any way, we 

will post updated material to peachpit.com.

Accessing the free Web edition  
and lesson files
Your purchase of this product in any format includes access to the corresponding 

Web Edition hosted on peachpit.com. The Web Edition contains the complete text 

of the book augmented with hours of video and interactive quizzes.

To work through the projects in this product, you will first need to download the 

lesson files from peachpit.com. You can download the files for individual lessons or 

download them all in a single file.

If you purchased an eBook from peachpit.com or adobepress.com, the Web  Edition 

will automatically appear on the Digital Purchases tab on your Account page. Con-

tinue reading to learn how to register your product to get access to the lesson files.

Getting Started xi
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If you purchased an eBook from a different vendor or you bought a print book, you 

must register your purchase on peachpit.com:

1 Go to www.peachpit.com/register.

2 Sign in or create a new account.

3 Enter ISBN: 978-0-13-439641-5.

4 Answer the questions as proof of purchase.

5 The Web Edition will appear under the Digital Purchases tab on your Account 

page. Click the Launch link to access the product.

The Lesson Files can be accessed through the Registered Products tab on your 

Account page. Click the Access Bonus Content link below the title of your 

product to proceed to the download page. Click the lesson file links to down-

load them to your computer.

Project fonts
All fonts used in these projects are either part of standard system installs or can be 

downloaded from Typekit, an Adobe service which is included with your Creative 

Cloud membership.

Additional resources
Learn Adobe Premiere Pro CC for Video Communication is not meant to replace docu-

mentation that comes with the program or to be a comprehensive reference for 

every feature. For comprehensive information about program features and tutorials, 

refer to these resources:

�� Adobe Premiere Pro Learn & Support: helpx.adobe.com/premiere-pro is 

where you can find and browse Help and Support content on Adobe.com. 

Adobe Premiere Pro Help and Adobe Premiere Pro Support Center are 

 accessible from the Help menu in Premiere Pro. Help is also available as a 

printable PDF document. Download the document at helpx.adobe.com/ 

pdf/premiere_pro_reference.pdf.

�� Adobe Forums: forums.adobe.com/community/premiere lets you tap into 

peer-to-peer discussions, questions, and answers on Adobe products.

�� Adobe Premiere Pro CC product home page: adobe.com/products/ 

premiere provides information about new features and intuitive ways to 

 create  professional-quality videos that play back on a wide range of devices.
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�� Adobe Add-ons: creative.adobe.com/addons is a central resource for finding 

tools, services, extensions, code samples, and more to supplement and extend 

your Adobe products.

�� Resources for educators: adobe.com/education and edex.adobe.com offer a 

treasure trove of information for instructors who teach classes on Adobe soft-

ware at all levels.

Adobe certification
The Adobe training and certification programs are designed to help video editors, 

designers, and other creative professionals improve and promote their product-

proficiency skills. The Adobe Certified Associate (ACA) is an industry-recognized 

credential that demonstrates proficiency in Adobe digital skills. Whether you’re 

just starting out in your career, looking to switch jobs, or interested in preparing 

students for success in the job market, the Adobe Certified Associate program is for 

you! For more information visit edex.adobe.com/aca.

Resetting preferences to their default settings
Premiere Pro lets you determine how the program looks and behaves (like tool set-

tings and the default unit of measurement) using the extensive options in Edit > 

Preferences (Windows) or Premiere Pro CC > Preferences (Mac OS). To ensure that 

the preferences and default settings of your Adobe Premiere Pro program match 

those used in this book, you can reset your preference settings to their defaults. 

If you are using software installed on computers in a classroom, don’t make any 

changes to the system configuration without first checking with your instructor.

To reset your preferences to their default settings, follow these steps:

1 Quit Adobe Premiere Pro.

2 Hold down the Alt key (Windows) or Option key (Mac OS).

3 Continue to hold the key and start Adobe Premiere Pro CC.

4 When the program’s splash screen appears, release the key.

Getting Started xiii



Chapter ObjeCtives

Chapter Learning Objectives
�� Create a rough cut.

�� Edit on the timeline.

�� Understand and edit coverage.

�� Edit audio transitions.

�� Create a title crawl.

�� Use adjustment layers and effects.

�� Review and export files.

Chapter ACA Objectives
For more information on ACA Objectives,  
see pages 235–238.

Domain 1.0  
SETTING PROJECT REQUIREMENTS

1.1, 1.2

Domain 2.0  
UNDERSTANDING DIGITAL VIDEO

2.4, 2.5

Domain 3.0  
UNDERSTANDING ADObE PREMIERE PRO CC

3.1

Domain 4.0  
EDITING A VIDEO SEQUENCE WITh ADObE 
PREMIERE PRO

4.1, 4.2, 4.3, 4.4, 4.5, 4.6

Domain 5.0  
ExPORTING VIDEO WITh ADObE PREMIERE PRO

5.1



Chapter 4

Editing a Dialogue 
Scene
In our next training scenario, Anytown High School has hired Brain Buffet 

to produce a series of short video clips that will help first-year students 

transition to high school. They will show these videos on their morning 

announcements and post them on their website. The first video you’ll pro-

duce for them is designed to let students know about the activity bus.

Preproduction
As you’ve learned, production can’t start until the project requirements are clearly 

understood, so it’s time to review those before you begin:

�� Client: Anytown High School

�� Target Audience: Anytown High School’s target audience is first-year students 

from 13 to 15 years old.

�� Purpose: The purpose of producing this video is to inform first-year students 

that they can still catch the activity bus at 4:30 p.m. if they miss the regular 

school bus or need to study in the library after school.

�� Actors: There is a principal and a student.

�� Goal: The goal is to ensure that first-year students know when the activity bus 

picks up students after school.

�� Deliverable: The client expects a 30-to-45-second video featuring two actors, 

a title, and voiceover. The video should be delivered in H.264 YouTube 

720p HD format.

 ACA Objective 1.1

 ACA Objective 1.2

 Video 4.1  
Introducing the 
activity bus video 
project
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Listing the available media files
In this project, some media has already been acquired for the project. What do you 

have to work with?

�� A photograph of the bus

�� Dialogue scene clips with good coverage (multiple angles to maintain visual 

interest by providing variety)

With those items you’re ready to start setting up the project.

Listing the preproduction files
There are other planning documents available to you for this project:

�� Project3_activityBus_Storyboard.pdf: You will get a medium shot, over-

the-shoulder shots, close-up shots, and a cutaway. Look at the storyboard 

for details on how the client sees this scene flowing, and use it as a guide for 

assembling the rough cut.

�� Project3Script.pdf: I have provided you with a copy of the script so you can 

track the dialogue. The actors were allowed to improvise on set, so the dia-

logue might not be exactly the same as the script. Still, it should cover all the 

key information.

�� Storyboard_template6panel.pdf: I provided this blank storyboard template 

so that you can create your own storyboards.

�� BusDetailsText.txt: You’ll use this text as a title and voiceover at the end of 

the video.

Setting Up a Project
Start the editing stage of production by using the project setup techniques you 

learned earlier in the book: 

1 Unzip the project files using the same techniques you used for the previous 

project.

2 Start a new project and name it Anytown HS Activity Bus.

3 Switch to a workspace that displays the Project panel, such as the Assembly 

workspace.

Note  
If this scene had been 
shot indoors, you 
would also have been 
provided with a WAV 
file capturing room 
tone. This is room 
background noise 
recorded with no dia-
logue. A room is not 
silent, and the back-
ground noise of every 
room has a slightly  
different character.  
The uniqueness of 
room tone lets the 
audio help the video 
establish a sense of 
place and distinguish 
different locations. 

 ACA Objective 4.1

 ACA Objective 4.2

 ACA Objective 4.3

 Video 4.2 Access 
and import your 
media
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4 Import media into the Project panel using the method you prefer, such as 

drag and drop, the Import command, or its keyboard shortcut.

5 Create a sequence based on a clip.

Creating a Rough Cut
In previous projects the video clips used in the Video 1 track were similar shots. 

They didn’t vary much in terms of field of view, point of view, or camera angle. 

This project includes more coverage of a scene and uses the traditional filmmaking 

technique of sequencing a standard set of varied shots to tell a story.

1 Create a new sequence from any of the video clips, but not the audio clip or 

the photo. Remember that you can create a sequence from a clip by dragging 

it from the Project panel to an empty Timeline panel.

It doesn’t matter which video clip you use to create the sequence because, at 

least in this case, they all have the same technical specifications.

2 In the timeline, delete the clip you dragged in since you used it only to create 

the sequence.

3 In the Project panel, select the sequence you just created.

4 Rename the sequence by clicking the filename of the selected sequence or by 

choosing Clip > Rename. Type dialog scene, and then press Enter (Windows) 

or Return (Mac OS).

Adding an establishing shot
You’ll add a wide-angle shot to establish the scene. Beginning with a wide shot is a 

traditional way to start a scene because it provides visual context about the location, 

the time, and sometimes the historical period.

1 In the Project panel, double-click the wide.mp4 video clip so that it opens in 

the Source Monitor.

2 In the Source Monitor, set the In point to where the principal is approaching 

the student (about 00:00:04:20), and set the Out point where the principal 

has turned and is about to speak to the student (about 00:00:08:00).

3 Drag wide.mp4 from the Source Monitor to the V1 track at the beginning of 

the dialogue sequence in the Timeline panel. This clip doesn’t seem to have 

audio when you listen to it, but it adds an empty audio track to the sequence.

 ACA Objective 4.4

 ACA Objective 4.5

 Video 4.3 Edit in 
the timeline
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Adding a medium shot and an adjustment
Now you’ll add a shot that moves in closer, filling more of the screen with the two 

characters as the sequence starts to focus more on the story rather than the setting.

1 In the Project panel, double-click the medium.mp4 video clip.

2 In the Source Monitor, set the In and Out points to the range where the 

 principal turns and says “Hi, what’s wrong?” Drag the clip to the timeline 

after the first clip.

Notice that the goal here is to establish and preserve visual and narrative con-

tinuity between the two shots. The In and Out points are chosen so that this 

clip picks up where the previous clip left off and moves the story forward. But 

if you play back the current sequence, you might notice that the timing of 

the edit isn’t ideal; the action at the end of the first clip repeats a little at the 

beginning of the second. You’ll need to make an edit between the two clips in 

the timeline.

3 In the Tools panel, select the Ripple Edit tool (  ).

4 In the Timeline panel, position the Ripple Edit tool just to the right of the 

edit between the clips so that the tool pointer faces to the right (Figure 4.1), 

because you want to edit the second clip.

 

5 Drag the Ripple Edit tool to the right so that it trims the beginning of the clip 

until the teacher reaches the bottom step of the stairs. It should now line up 

much better with when the previous clip left off.

6 Position the Ripple Edit tool just before the edit so that the pointer faces left, 

and drag to trim the end of the wide shot until it ends precisely when the 

next clip begins. The Program Monitor dual view of both clips should help 

you see when the timing is just right.

Figure 4.1 Preparing to 
edit the second clip with 
the Ripple Edit tool

tip  
If both clips are synced 
but the edit is at the 
wrong time, use the 
Rolling Edit tool (  ) 
to shift the Out point 
of the first clip and the 
In point of the second 
clip simultaneously.
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Editing audio to repair silence
Audio continuity is just as important as video continuity, so it’s a problem that 

the first clip has a silent audio track. You’ll extend the background audio that was 

recorded before the In point of the second clip.

1 In the Timeline panel, select the wide.mp4 clip and choose Clip > Unlink. 

Then select the audio portion of the clip and press Delete.

2 With the Selection tool (  ), Alt-drag (Windows) or Option-drag (Mac OS) 

the In point of the audio portion of the medium.mp4 clip and drag it to the 

left until it extends all the way to the start of the sequence (Figure 4.2).

 

If you synced the two clips properly on the video track, the sound of steps in the 

second track should fit perfectly with the steps seen in the video of the first track.

Building the rest of the sequence
At this point you can use the remaining clips to complete the sequence as an exer-

cise. Because this is a dialogue scene, you’ll set In and Out points for each clip 

based on when each character says a line. For reference, follow Project3Script.pdf 

and Project3_activityBus_Storyboard.pdf in the Pre-production folder. The general 

idea is to use the clips to visually support the dialogue.

You can add the cutaway_phone.mp4 file where the student mentions that her 

phone is dead.

After you add all of the remaining clips, play back the entire sequence. You’ll prob-

ably find that you need to adjust some of the edits in the sequence. Depending on 

the types of edits to be made, you’ll have to use a variety of tools. To learn what 

each tool does, see the Tools panel overview in Chapter 1.

At the end of the sequence, you can add a Dip to Black video transition to fade 

it out.

Figure 4.2 Dragging just 
the audio portion of the 
medium.mp4 clip
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Getting enough coverage
You’ve probably noticed that the clips in this sequence repeat the same dialogue 

from different angles and distances. Being able to choose from different shots for a 

single scene is possible only when the shots were planned this way by the director 

and the production team. You can achieve similar coverage by specifying them in 

your shot list. Some productions get their coverage by running multiple cameras 

at the same time, whereas smaller productions might use one camera and have the 

actors repeat a scene for each shot that’s needed.

Fixing Audio in Adobe Audition
This exercise is a simple example of how you can edit an audio clip by round- 

tripping between Adobe Premiere Pro CC and Adobe Audition CC. Audition is a 

powerful audio editing application that’s included with your Creative Cloud sub-

scription, and it’s capable of fixing audio problems that are too challenging for 

the audio features in Premiere Pro. For example, you can use Audition to clean up 

audio by removing noise and unwanted sounds such as pops.

To make the fix shown in the video:

1 Make sure that you have installed Adobe Audition CC using the Adobe 

 Creative Cloud desktop application.

2 Back in your Premiere Pro project, select the medium.mp4 clip in the dialogue 

scene sequence in the Timeline panel.

3 Choose Edit > Edit in Adobe Audition > Clip. 

Audition opens and displays the audio clip with its waveform.

tip  You can also right-click (Windows) or Control-click (Mac OS) and 
choose Edit Clip in Adobe Audition.

4 In the heads-up display (HUD), scrub the audio level value to the right until it 

maxes out at +15. This value is relative to the starting audio level of the clip.

You’re trying to boost the level until it reaches about –6 dB on the scale along 

the right side, but because the HUD is limited to +15 dB per adjustment, 

you’ll have to scrub it a second time.

 ACA Objective 2.4

 ACA Objective 4.6

 Video 4.4  
Sweeten the audio
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5 Scrub the HUD level to the right again until 

the waveform peaks at about –6 dB on the scale 

along the right side (Figure 4.3). Many video 

 editors use –6 dB as a guideline for a good level 

for dialogue.

6 Save your work in Audition, and switch back to 

Premiere Pro.

In the Timeline panel, the waveform for 

medium.mp4 should now be higher.

In the Project panel, note that there is a new 

audio file called medium Audio Extracted.wav. 

This is the audio from the medium.mp4 clip 

that’s currently used in the sequence. It was 

extracted from the video clip, edited in Audition, 

and automatically replaced the original audio 

clip in the timeline.

Audition is also professional multitrack audio workstation software, so you can 

mix a video’s soundtrack with much more control and precision than you can 

in  Premiere Pro. You could say that Audition is as optimized for audio editing as 

 Premiere Pro is for video editing. 

Audition and Premiere Pro are integrated, so you can move clips between them 

without having to manually import and export. For example, you could bring in all 

of the audio tracks from a video project, use the advanced audio production fea-

tures in Audition to create the mixes for each of your final formats (such as stereo 

and surround sound), and then use those sound mixes for the final version of your 

Premiere Pro project.

Applying Video Adjustments
Just like still photos, video clips often need a little work after they come out of the 

camera. Even if your shots are technically correct, they might require additional 

adjustment when lighting conditions aren’t ideal or the camera wasn’t set correctly.

 Video 4.5 Make 
tonal range 
adjustments

Figure 4.3 Scrubbing the audio levels HUD in Audition
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Adjusting video levels
Just as audio clips sometimes need a levels adjustment, video clips may need to 

be made lighter or darker. The Levels video effect is a common way to lighten or 

darken a clip. As you’ve already learned, you can apply an effect to a clip by simply 

dragging it from the Effects panel and dropping on a clip.

1 In the Anytown HS Activity Bus project, open the Effects panel.

2 Find the Levels video effect (by typing levels in the Search field or choosing 

it in the Video Effects > Adjust group). Drag Levels from the Effect  Controls 

panel and drop it on the overShoulder.mp4 clip in the dialogue scene 

sequence in the Timeline panel.

3 In the Effect Controls panel, do one of the following:

�� In Windows, click the Settings button (  ). In the Level Settings dialog 

box, under the histogram, drag the black slider to 33, drag the middle gray 

slider to 0.73, and drag the white slider to 251.

�� In Windows or Mac OS, set (RGB) Black Input Level to 33, (RGB) White 

Input Level to 251, and (RGB) Gamma to 73 (Figure 4.4).

4 Disable the effect by clicking the fx button (  ) next to the Levels label in the 

Effect Controls panel. Click the fx button again to enable the effect.  Toggling 

the fx button is a good way to get a before/after view of an effect.

Note  
Although the Level Set-
tings dialog box is not 
available in Mac OS, 
you can immediately 
see the results of your 
Effect Controls adjust-
ments in the Program 
Monitor.

Figure 4.4 Adjusting the Levels effect in the Effect Controls panel
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The Levels effect is a good place to start, and it should be familiar if you’ve used 

Adobe Photoshop. Premiere Pro includes other effects that can adjust levels in ways 

you might find more intuitive, such as the Three-Way Color Corrector in Chapter 5.

Applying an adjustment layer
By now you’re familiar with how to apply an effect to a clip. But what if you want 

to apply the same effect to many clips in a sequence? Although there is a way to cut 

and paste effects from clip to clip, even that can be tedious if you have an hour-

long program with hundreds of clip instances.

In Premiere Pro you can apply an effect to an entire track by using an adjustment 

layer. If you’ve used adjustment layers in Photoshop, you already have an idea 

about how it works: An adjustment layer is like a clip in that it appears in the Proj-

ect panel after you create it, but it contains only an effect and no content. If you 

add an adjustment layer to a sequence, any effects you apply to the adjustment 

layer also apply to all clips in lower tracks.

1 In the Project panel, click the New Item button (  ) and choose Adjustment 

Layer. Accept the default settings by clicking OK. A new item named Adjust-

ment Layer is added to the Project panel.

If you want to change its name, you can rename it in the same way you 

renamed other Project panel items earlier.

2 Drag Adjustment Layer and drop it on track V2 in the Timeline panel. Drag its 

ends so that its duration matches the entire sequence (Figure 4.5).

 

tip  
You can also  
choose File > New > 
 Adjustment Layer  
if the Project panel  
is active.

Figure 4.5 An adjust-
ment layer added to the 
timeline
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3 In the Timeline panel or Program Monitor, move the playhead to a frame 

inside the second clip.

4 Find the Fast Color Corrector video effect (either by typing part or all of its 

name in the Search field or by choosing it from the Video Effects > Color 

 Correction group). Drag Fast Color Corrector from the Effect Controls panel 

and drop it on the adjustment layer on track V2 in the Timeline panel.

5 In the Effect Controls panel, scroll to find the Fast Color Corrector effect.

6 In the Fast Color Corrector effect, select the White Balance eyedropper;  

then in the Program Monitor, click the eyedropper on a white area of the sign 

near the left edge of the frame. This samples the white as the reference for 

shifting the clips’ white balance to neutral (Figure 4.6).

Notice that in the Fast Color Corrector, the Balance Magnitude handle (the 

small circular handle near the center) has moved out along the color wheel to 

indicate which hues it has boosted and by how much.

7 Check your work by using the Fast Color Corrector fx button (  ) to disable 

and enable the effect.

White Balance eyedropper

Balance Magnitude handle

White Balance eyedropper 
clicked in Program Monitor

Figure 4.6 Using the Fast 
Color Corrector
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As with other clips you’ve worked with on the timeline, the default rubber band 

for an adjustment layer is Opacity. For an adjustment layer, reducing its opacity 

reduces the strength of the effect. And as with rubber bands in general, you can add 

keyframes to the Opacity rubber band to vary the strength of the effect over time. 

For example, if you need to make multiple white balance corrections throughout a 

single clip because the camera moved among different-colored light sources (such 

as from daylight into a room lit by fluorescent lightbulbs), you can add a keyframe 

at each time where you need to make a color balance change and adjust the Fast 

Color Corrector values at each keyframe.

Recording a voiceover
To help drive home the message that this video needs to deliver, it ends with a 

voiceover and title based on the same text. You’ll create the title soon, but right 

now it’s time to record the voiceover. You’ve recorded a voiceover earlier in this 

book, so use this exercise to practice what you’ve learned. This time, though, you’ll 

be using a script that’s provided with the media files for this project. Record the 

voiceover according to these requirements:

1 Before recording, make sure your microphone is set up correctly in the Audio 

Hardware pane of the Preferences dialog box in Premiere Pro.

2 Record the voiceover to audio track A2 in the sequence.

3 Read from the script BusDetailsText.txt that’s included with the media files for 

this project.

4 After the voiceover is recorded, make any adjustments that are necessary to 

merge it smoothly with the preceding clips, such as trimming the ends or 

adding an audio transition.

Add a Still Image to the Sequence
You just recorded a voiceover at the end of the sequence, but the video track is cur-

rently empty. To provide a visual background for the voiceover, you’ll add a photo-

graph of a bus and also add a title that reflects the voiceover and animates into the 

scene for additional visual interest and emphasis.

 ACA Objective 2.5

 ACA Objective 3.1

 Video 4.7 Add a 
photo and title
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Create a title to superimpose over the image
Create a new title using the text of the script. It will appear over the image of a bus 

that you’ll add soon. Because you’ve created several titles by now, this should be a 

familiar task:

1 Name the title bus time.

2 Paste the title text into the title, and format it to fit within the Safe Title 

margins.

3 Use the Title window tools and settings to format the text for readability.

When you’re done (Figure 4.7), close the Title window so that you can prepare the 

image that will display under the title.

Add a still image
You can add a still image to a sequence the same way you’ve added video, audio, 

and titles: by dragging it from the Project panel or a bin into the Timeline panel. 

As with most photos, the aspect ratio of the image is different from the 16:9 video 

frame. Fortunately, it’s easy for you to resize and reposition the image anywhere in 

the frame.

1 Drag the file bus.jpg to the end of the sequence in the Timeline panel.

The still image comes in using the Still Image Default Duration specified in 

the General panel of the Preferences dialog box in Premiere Pro, so you’ll 

need to adjust the duration.

Figure 4.7 Preparing the 
bus time title
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2 Drag the Out point of the bus image to make its duration match the voiceover 

audio.

3 In the Program Monitor, double-click the bus image. Handles should appear 

on a bounding box around the image.

4 Drag a handle to resize the image so that it fills the frame without any black 

bars on the sides (Figure 4.8).

 

Figure 4.8 Handles for 
resizing a still image in 
the Program Monitor

If you don’t see bounding box handles and you see only the middle of the bus, the 

image is probably much bigger than the frame and its handles are probably out-

side the frame. This is normal because digital camera images usually contain many 

more pixels than even an HD video frame. To fix this, go to the Program Monitor 

and choose a low magnification such as 25% or 10% so that you can see the area 

outside the frame. This should make the clip handles visible. Now you can drag a 

handle to fit the image in the frame.

Some digital cameras record frames with a 3:2 aspect ratio; others record frames 

with a 4:3 aspect ratio. Images with those aspect ratios will need to be recomposed 

to fill a 16:9 HD video frame without black bars on the sides. A few cameras let you 

select a 16:9 aspect ratio.

Set up the title to crawl left and hold
Now it’s time to add the title over the bus image.

1 In the Project panel, find the bus time title you created and drag it to the 

Timeline panel into a track above the bus image.

2 Adjust the title’s In point so that it starts a couple of seconds after the bus 

image, and drag its Out point to end when the voiceover and bus image end.
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Figure 4.9 The Roll/Crawl Options dialog 
box

3 Double-click the title to open it.

4 Choose Title > Roll/Crawl Options. Select the Crawl Left 

and Start Offscreen options, enter 150 in the Preroll option 

( Figure 4.9), and click OK.

The options you see in the Roll/Crawl Options dialog box oper-

ate as follows:

�� The Crawl Left option animates the title from right to left

�� The Start Offscreen option positions the title beyond the 

right edge of the frame so that the crawl brings it into 

the frame

�� The 150-frame postroll finishes the crawl 150 frames before the end of the 

title duration so that it holds for 5 seconds (5 times 30 frames per second).

Play back the sequence and see if your results match the example in the tutorial 

video; make any adjustments as needed.

Blur the background at a specific time
Although the title works, it’s hard to read over the visually busy bus photo. 

You’ll fix this problem by blurring the bus photo. You can apply video effects to 

still images.

1 Find the Fast Blur video effect by searching for it or choosing it from the 

Video Effects > Blur and Sharpen group. Drag Fast Blur from the Effect 

Controls panel and drop it on the bus.jpg image in the Timeline panel 

(Figure 4.10).

2 Move the playhead to the time when the title is about to come to a stop.

3 In the Effect Controls panel, make sure the bus.jpg tab is active, and expand 

the Camera Blur options.

Figure 4.10 Applying 
Fast Blur to the bus image
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4 Immediately to the left of the Blurriness option, click the Toggle Animation 

stopwatch so that it’s blue.

5 In the Blurriness option, type 100 and press Enter or Return (Figure 4.11). 

You can apply a little more or less blurriness if you like (the value can go 

above 100).

Notice that the Add Keyframe button becomes selected, because changing a 

value when the Toggle Animation stopwatch is on automatically adds a key-

frame at the playhead.

6 Move the playhead to the beginning of the bus.jpg image. In the Effect 

 Controls panel, set Blurriness to 0.

Play back this part of the sequence. The title should slide in from the right as the 

bus image becomes blurry, and the title should stop and hold in the middle of the 

frame 5 seconds before the bus image ends.

Reviewing with Your Clients  
and Exporting the Final Video
At some point your clients are going to want to see what you’ve been working 

on for them, maybe even before you’re finished with the project. You don’t need 

to export video to show the client a full-screen presentation; you can do it from 

 Premiere Pro itself.

 ACA Objective 5.1

 Video 4.8  
Preview and review

Toggle Animation 
stopwatch

Blurriness  
value

Add Keyframe 
button

 
Keyframe

Figure 4.11 Adjusting the 
Blurriness value
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Reviewing a project using Cinema mode
Cinema mode can help you and your clients review a project while you’re still 

working on it in Premiere Pro. In Cinema mode you can present full-screen play-

back of a clip or a sequence.

1 Do one of the following:

�� To present the active clip in the Source Monitor, click it.

�� To present the active sequence in the Program Monitor, click it.

2 Press Ctrl-` (the tilde key) in Windows or Control-` in Mac OS. The monitor 

you clicked expands into full-screen mode.

3 If you want, you can use the keyboard shortcuts for navigating the time-

line, such as pressing Home or End to go to the start or end, respectively, or 

pressing the Up Arrow or Down Arrow key to go to the previous or next edit, 

respectively.

4 Press the spacebar to start or pause playback.

5 To exit Cinema mode, press Ctrl-` (Windows) or Control-` (Mac OS) or the 

Esc key.

Exporting the final video
Before you export final video, remember to play it back all the way through and 

make sure there are no more adjustments or corrections to be made. You may want 

to play it back several times to focus on different aspects of the production. For 

example, you might spend one pass just watching the timing of edits and another 

pass just listening to the audio. Pause playback whenever you notice something 

that needs attention, and add it to a checklist. Rendering final video can take a long 

time, so it’s more efficient to take care of problems before you export.

After you choose File > Export Media, double-check specifications such as the 

source range, the format, the preset, the output name, and the folder location. 
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Challenge: Create Your 
Own Dialogue Scene
Now that you’ve built a dialogue scene by using the media provided and complet-

ing these exercises, create your own dialogue scene. You can try a variation on the  

theme of this chapter’s project of orienting new high school students. Provide 

directions to important rooms or buildings such as a cafeteria or gym, show the 

 students what to do in an emergency, or explain how to use the library.

As you plan your documentary, remember Joe Dockery’s Keys to Success (from 

the video):

�� Keep it short.

�� Plan. Write a good script and storyboard. You can use the storyboard_ 

template6panel.pdf file in the Pre-Production folder for this chapter, which 

contains a grid of six blank storyboard panels.

�� Shoot good-quality video and record good-quality audio. For video, light sub-

jects in a flattering way. For audio, keep the microphone close to the person 

speaking and monitor the audio using headphones. Good monitoring helps 

you catch problems while you can fix them, since you don’t want to have to 

do an interview twice.

�� Get complete coverage. Shoot the entire scene from multiple angles.

�� Share your work and continue to build your portfolio.

Conclusion
In this chapter you’ve had a chance to spend more practice time on valuable basic 

skills such as editing video, editing audio, and creating titles. You’ve added some 

new abilities such as working with still images, editing audio in Adobe Audition CC, 

and keyframing effects. Keep practicing with your own ideas and projects, and let’s 

continue on to the next chapter.

 Video 4.9 Dialogue 
video challenge
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CC (Creative Cloud) Libraries, 16
Cinema mode, using to review 

projects, 108
client’s needs, understanding, 

206–209
clip instances, renaming, 75
clip logging, streamlining, 228
Clip mobile app, 232–233
clip speed and duration, 

changing, 155
clip volume, adjusting, 52–53
clips. See also B-roll clips

adding for rough cuts, 41
changing playback speeds, 

78–81
creating video sequences 

from, 44
deleting parts of, 72–74
dragging, 52
extracting still frames from, 44
going to beginning of, 151
logging and naming, 9
moving in time, 48, 152–153
In and Out points, 155
removing from timeline, 48
selecting in Timeline panel, 

152–153
slicing, 156
splitting, 155–156
stabilizing, 88–90
trimming in Timeline panel, 

47–48
white balancing using gray 

target, 113–114
closing panels, 24
CMYK (cyan, magenta, yellow, 

black) color, 182
collaboration

coordinating, 8–9
on teams, 3

color, element of, 168, 181–187
Color workspace, 28
color-grading clips with 

Speedgrade, 229
column order, changing, 37
commands. See also keyboard 

shortcuts
accessing, 136
Add Edit, 156
Frame Hold, 155

complementary colors, 185

audio. See also MP3 audio file
adding to Timeline panel, 48
designing, 86
editing, 51–53
editing to repair silence, 97
editing separately from 

video, 48
fixing in Adobe Audition, 98–99
preventing on main video 

track, 77
audio levels, varying over time, 

52–53
audio meters, 23, 71
audio track controls, 46, 49–50
audio transitions, applying, 75–76
audio waveform, looking at, 74
Audition Adobe Cloud desktop 

application, 98–99, 229

B
background, blurring, 106–107
backletter fonts, 190
backslash (\), using in Timeline 

panel, 46
Backspace/Delete, 74
balance, principle of, 195, 199–200
balance and proximity, 

creating, 166
bins, displaying as hierarchy, 37
black bars, appearance in Export 

Settings, 63
blog, accessing, 20, 234
Brain Buffet Media Productions, 

18–21, 111, 121
brainstorming, 219
Bridge Adobe Cloud desktop 

application, 230–231
B-roll clips, adding, 76–77. 

See also clips
Burns, Ken, 138–139
bus image, applying Fast Blur 

to, 106
bus time title, preparing, 104
buttons. See panel buttons

C
Capture mobile app, 232–233
Capture window, importing 

with, 38
cast shadow in 3D lighting, 

177–178

Index
SymBol
\ (backslash), using in Timeline 

panel, 46

NumBerS
3D lighting, elements of, 177–178

A
Add Edit command, 156
Add Marker control, 46
additive color, 182
adjustment layers, applying, 

101–103
Adobe 

Capture app, 186
Communities forum, 19, 234
mobile apps, 232–233
website, 14

Adobe Cloud desktop applications
After Effects, 229–230
Anywhere, 231
Audition, 98–99, 229
Bridge, 230–231
Media Encoder, 63–64, 140–143, 

230
Prelude, 228, 233
Speedgrade, 229
Story Plus, 228

.ai extension, 85
alignment, principle of, 195
Alpha Channel setting, 118
Alt key. See keyboard shortcuts
analogous colors, 185
animated logo, adding, 120–122
Anytown High School client, 93
application window, resizing, 26
art elements

color, 181–187
diagram, 168
form, 177–178
framework, 166–167
line, 172–174
shape, 175–176
space, 169–171
texture and pattern, 179–180
type, 187–194
value, 180–181

Assembly workspace, 28
asymmetrical balance, 199–200

Index 239



F
fair use policy, 212–213
Fast Blur, applying to bus image, 

106
Fast Color Corrector fx button, 

102, 114
feedback loop, using, 224
files. See also media files

linking to, 6–7
organizing into folders, 11
storing, 7–9

final video, exporting, 89–90,  
107–108, 126–127.  
See also videos

focal point, creating in design 
hierarchy, 165, 196–197

folders, organizing files into, 11
fonts

accessing list of, 188
types of, 190

form, element of, 168, 177–178
forward delete key, 74
Frame Hold commands, 155
frames

freezing, 81–83
identifying in time notation, 43
moving back and forward, 

90, 151
searching timeline for, 151

Free Draw Bezier tool, 116
freezing frames, 81–83
fx button, clicking, 100

G
garbage matte, drawing, 115–119
General tab, configuring, 13–14
.gif extension, 85
GPU Acceleration option, 14
graphics. See also images

adding and animating, 120–126
file formats, 85
importing with transparent 

backgrounds, 85
resizing in titles, 85

graphics applications, 231–232
graphics cards, 14
gray target, using to white balance 

clips, 113–114
green background, keying out, 

117–119
green screen clips, preparing to 

shoot, 114–115
green spill, addressing, 119

drives, working with, 7–8.  
See also Scratch Disks tab

Drop Shadow video effect, 
applying, 125–126

Duplicate button, 126–127

e
Ease In command, applying, 122
editing

audio, 51–53
audio and video separately, 48
audio to repair silence, 97
keyboard shortcuts, 158
keyframes, 122, 156–157
rough cuts for interviews, 71–75
in Timeline panel, 47–48
titles, 87
values, 58

editing interviews
audio transitions, 75–76
B-roll clips, 76–77
exporting video, 89–90
freezing frames, 83
lower-third titles, 83–85
nesting sequences, 81–83
playback speed of clip, 78–81
preproduction, 69
project setup, 70
rolling credits, 87
rough cut, 71–75
sound design, 86
stabilizing clips, 88–89
stereo clip with mono 

recording, 70–71
video sequences, 39, 45

Editing workspace, 28–29
Effect Controls panel, 54
effects, finding, 76. See also After 

Effects; video effects
Effects panel, 22
emphasis, principle of, 196–197
End key, navigating sequences 

with, 72
evaluating projects, 224–225
Export Frame button, 44
Export Settings dialog box, 61–65
exporting

final video, 89–90, 107–108, 
126–127

sequences to video files, 61–65
versions with Media Encoder, 

140–143

compositing with green screen 
effects

animating graphics, 120–126
clip with background, 115–119
exporting final video, 126–127
preproduction, 111–112
project setup, 112–114

Constant Gain transition, 75
Constant Power transition, 75
content, importing, 6
context menu, opening for 

clips, 158
contrast

including in images, 166
principle of, 195, 197

cool colors, 183
copyrights, 210–214
Creative Cloud Libraries mobile 

app, 233
Creative Commons licenses, 

214–215
creativity, skill of, 162–163
Ctrl key. See keyboard shortcuts
curved segments, creating, 117

D
decorative fonts, 190
default transition, selecting, 135, 

137–138
Delete key, 74
deleting parts of clips, 72–74
demographic, targeting for projects, 

208–209
design hierarchy, applying, 164–167
design principles, 196–202
desktop, revealing, 26
dialogue scene

exporting final video, 107–108
fixing audio, 98–99
media files, 94
preproduction, 93–94
project setup, 94–95
reviewing with clients, 107–108
rough cut, 95–98
still images in sequences, 

103–107
video adjustments, 99–103

dingbat fonts, 191
divider, dragging, 23–24
dragging

clips, 52
dividers, 23–24
magnification scroll bar, 151
media files, 36
transitions, 53–55
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maximizing panels, 29
Media Browser panel, 36
Media Encoder CC

exporting files with, 63–64, 
140–143

features, 230
media files. See also files

finding, organizing and 
inspecting, 230–231

importing into projects, 35–36
memorial slide show, 131
Mercury Playback Engine, 14
metadata

adding to videos, 62
customizing columns, 37
repeating for exported 

sequences, 62
Metadata panel, reopening, 25
microphone, selecting in Audio 

Track Mixer panel, 49–50
mobile apps, 232–233
mono recording, filling stereo clip 

with, 70–71
monochromatic colors, 185
monospaced fonts, 190
motion, adding to images, 138–139
movement

and alignment, 166
principle of, 195, 202

moving clips in Timeline panel, 
152–153

MP3 audio file, setting up, 126–127. 
See also audio

Mute audio track control, 46

N
naming clips, 9
negative space, 171
nesting sequences, 81–83
New Project dialog box.  

See also projects
General tab, 13–14
Scratch Disks tab, 15–16

notes, adding to markers, 138

o
object shadow in 3D lighting, 

177–178
opacity mask, drawing, 115–119
opening titles, creating with 

video, 82. See also titles
OS X, starting Premiere Pro in, 

11–12
Out points. See In and Out points
output, creating with Media 

Encoder, 230

keyboard shortcuts.  
See also commands

adding points, 53
Apply Video Transition, 137
building rough cuts, 44
editing, 158
Import command, 147
JKL, 44, 46
Macs versus PCs, 74
sequence navigation, 72
Time Remapping, 81
using, 157–158

keyboards, Mac and PC, 74
keyframes, editing, 122, 156–157

l
layered Photoshop documents, 

importing, 112–113.  
See also Photoshop

layers, applying, 101–103 
leading in typography, 192
legal issues, addressing, 34
Levels effect, adjusting, 100
licensing, 214–215
ligatures in typography, 194
light source in 3D lighting, 177–178
line, element of, 168, 172–174
line art, creating with 

Illustrator, 232
List view, scrolling, 37
listing media files, 34
lists, sorting, 37
Lock icon, enabling, 48
Lock track control, 46
logging clips, 9
logo, animating, 120–122
lowercase letters, 193
lower-third titles, creating, 83–85. 

See also titles
Lumetri Scopes panel, 28

m
Mac keyboards, 74
magnification, 43, 151
map, adding weather graphics to, 

123–126
margin guides, 60
markers

adding, 43, 46
adding items at, 136–138
adding notes to, 138

masks
previewing against black 

background, 119
using, 169

Matte Cleanup options, 
accessing, 119

H
Hand tool, 47
handwritten fonts, 190
help, getting, 19–20
highlight in 3D lighting, 177–178
highlight videos, 69
Hollywood-style special effects, 

229–230
Home key, navigating sequences 

with, 72
hover-scrubbing, 37
hues in color wheel, 183
human creativity, graph of, 162

I
Illustrator, graphics 

applications, 232
images. See also graphics

adding to titles, 58–59
including contrast in, 166

Import command, 147
Import Sequence option, 148
importing

with Capture window, 38
content, 6
graphics with transparent 

backgrounds, 85
layered Photoshop documents, 

112–113
media files into projects, 35–36

In and Out points
adding for rough cuts, 43
for clips, 155
explained, 38
settings, 41

information details, inspecting, 37
integration, explained, 3
interviews. See editing interviews

J
JKL keyboard shortcuts, 44, 46
job requirements, identifying, 

33–34
Joe’s Construction Cruisers 

video, 33
JPEG (Joint Photographic Experts 

Group), 85

K
Ken Burns motion effect, adding, 

138–139
kerning in typography, 192
Key Color eyedropper, 117–118
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resizing
application window, 26
graphics in titles, 85
still images, 105

resources, 233–234. See also 
websites

reviewing projects with clients, 
107–108

RGB (red, green, blue) color, 182
rhythm, principle of, 202
ripple deletes, 73–74
ripple edits, performing, , 47–48, 

72, 96, 153
Roll/Crawl Options dialog box, 106
rolling credits, creating, 87
Rolling Edit tool, 47, 96, 153
rotation angles, specifying, 122–123
Rotation keyframe, adding, 121
rough cuts

creating, 41–45
dialogue scene, 95–98
editing for interviews, 71–75
getting enough coverage, 98
streamlining, 228

rubber band, displaying for clips, 
156–157

rule of thirds, 170

S
safe margins, 60
sans serif fonts, 189
scale

principle of, 201
and proportion, 166–167

Scratch Disks tab, configuring, 
15–16. See also drives

script fonts, 190
scriptwriting with Story Plus, 228
scrubbing

explained, 151
using Shift with, 125

Selection tool, 47, 52, 117, 152
sequences

adding items at markers, 
136–138

adding items at regular 
intervals, 135–136

adding titles to, 59–60
basing in presets, 133–134
creating, 39–41
creating from clips, 44
creating from multiple files, 

133–139
editing, 39
editing in Timeline panel, 47–48
exporting to files, 61–65

presets
basing sequences on, 133–134
dropping onto sequences, 127

primary colors, 183–184
problems, understanding, 217–218. 

See also solutions
Program Monitor panel, 

controls, 43
Program panel, 20–21
project creep, avoiding, 222–223
project folders, managing, 9
project management, 216–217
Project panel

contents of, 20–22
organizing photos in, 134
using, 36–37

project requirements, setting, 
221–222

projects. See also New Project 
dialog box

editing settings, 16–17
locating, 16–17
reopening, 19
reviewing with Cinema 

mode, 108
setting up, 147–148
setup for dialogue scene, 94–95
setup for edited interviews, 70
setup for weather report, 

112–115
testing and evaluating, 224–225

promo video, elements of, 33
proportion, principle of, 195, 201
.psd extension, 85

Q
quiet passages

removing, 74
repairing, 97

r
radial balance, 200
Rate Stretch tool, 47–48, 78, 

120, 155
Razor tool, 47–48, 155–156
recording voiceovers, 49–50, 103
reflected highlight in 3D lighting, 

177–178
releases, obtaining, 215
renaming clip instances, 75
render bars, colors of, 45
repetition

principle of, 201
and rhythm, 167

research, conducting, 218

P
panel buttons, customizing, 51
panels

arrangement of, 20–21
arranging, 23–27
closing, 24
displaying, 19
dragging dividers, 23–24
maximizing, 29
types of, 22–23
undocking, 26

pattern
principle of, 195, 201
and texture, 179–180

PC keyboards, 74
Pen tool

editing keyframes with, 156–157
identifying, 47
using with audio level, 52

performance, accelerating, 14
permissions, obtaining, 34, 215
perseverance, importance to 

creativity, 162
photos. See also graphics; images

adding to timeline 
automatically, 135–136

organizing in Project panel, 134
Photoshop, 231. See also layered 

Photoshop documents
playback

controlling in timeline, 151
improving during editing, 45
resolution, 43, 45, 125

playback speed
changing for clips, 78–81
increasing, 46

playhead
control, 46
moving in time, 46, 151
Position time display, 43, 46
transport controls, 43

.png extension, 85
points, adding, 53
Position keyframe, adding, 121
preferences, setting, 16–17
Prelude 

Adobe Cloud desktop 
application, 228

Live Logger mobile app, 233
Premiere Pro

blog, 20, 234
product page, 233
starting, 11–12
support and updates, 19
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tracking in typography, 192
tracks

adding, 120
adding to sequences, 122
controlling, 46
expanding, 149
preventing locking, 48
targeting, 149–150

transcoding, 64
transitions

previewing, 76
setting defaults for, 135–136
using, 53–55

trimmed clips, adding, 41–42
trimming

clips, 152–155
locking at, 47
with tools, 48

type, element of, 168, 187–194

u
unity

principle of, 195
ranging to variety, 166

uppercase letters, 193
user interface, guidelines, 19

V
value

editing, 58
element of, 168, 180–181

variety, principle of, 198
versions, exporting with Media 

Encoder, 140–143
video adjustments, applying, 

99–103
video and audio, editing 

separately, 48
video clips. See clips
video effects, using, 53–55.  

See also effects
video sequences

adding items at markers, 
136–138

adding items at regular 
intervals, 135–136

adding titles to, 59–60
basing in presets, 133–134
creating, 39–41
creating from clips, 44
creating from multiple files, 

133–139
editing, 39
editing in Timeline panel, 47–48
exporting to files, 61–65
extracting still frames from, 44

subtractive color, 182
support, getting, 19, 233–234
swashes in typography, 194
sweetening audio, 98–99
symmetrical balance, 199

T
target audience, defining, 208–209
targeting tracks, 149–150
temperature, adding to sun, 123
testing projects, 224–225
text, adding to titles, 57
texture

element of, 168, 
and pattern, 179–180

themes and feeling, creating, 167
Thumbnail view, 36–37
.tif extension, 85
time, snapping to, 83
Time magnification control, 46
time notation, 43
Time Remapping, 79–81
time values, altering, 83
Timeline panel

\ (backslash) in, 46
controls, 46
editing in, 47–48
locating, 20–21 
navigating in, 150–152
selecting and moving clips in, 

152–153
settings, 46
Snap button, 149
using, 46
working in, 148–150

tints in color wheel, 183
title sequence, nesting in main 

sequence, 82–83
titles. See also lower-third titles; 

opening titles
adding images to, 58–59
adding text to, 57
adding to sequences, 59–60
crawling left and holding, 

105–106
creating, 56
dropping into timeline, 59
editing, 87
editing duration of, 60
resizing graphics in, 85
superimposing over images, 104

tonal range adjustments, 99–103
tones in color wheel, 183
Tools panel, 23, 47
Track labels controls, 46
Track Select tools, 47–48

extracting still frames from, 44
going to beginning of, 151
importing, 148
navigating, 72
nesting, 81–83
preparing items for, 134
rough cuts, 41–45
transitions, 53–55

serif fonts, 189–190
settings

editing for projects, 16–17
icon, 43

shades in color wheel, 183
shadow in 3D lighting, 177–178
shape

adding to title, 57
element of, 168, 175–176

Shift key. See keyboard shortcuts
Show/hide track in Program 

Monitor, 46
shortcuts. See keyboard shortcuts
slicing clips, 156
slide show. See video slide show
Slide tool, 47–48
Slip and Slide tools, using, 47–48, 

153–155
Snap button, identifying in 

Timeline panel, 149
snapping to time, 83
snowboarding highlight videos, 69
Solo audio track control, 46
solutions, picking and planning, 

220. See also problems
sorting lists, 37
sound. See audio
Source Monitor

controls, 43
setting In and Out points, 41

Source panel, 20–21
space, element of, 168–171
specifications, using, 222
Speedgrade Adobe Cloud desktop 

application, 229
splitting clips, 155–156
SSD (solid-state drive) storage, 8
stereo clip, filling with mono 

recording, 70–71
still frame, extracting, 44
still images

adding to sequences, 104–105
placing at markers, 137
resizing, 105

Story mobile app, 232–233
Story Plus Adobe Cloud desktop 

application, 228
storyboards, using, 222
studio workflows, optimizing, 231
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y
YouTube, exporting sequences for, 

62–63

Z
ZIP files, unpacking, 10
zooming, 46–47

Vocal Enhancer audio effect, 
applying and editing, 51–52

voiceovers, recording, 49–50, 103
volume of clips, adjusting, 52–53

W
warm colors, 183
Warp Stabilizer, 88–89
weather graphics, adding to map, 

123–126
web-based resources, 233–234
websites. See also resources

Adobe, 14
Adobe Communities forum, 19
Adobe Creative Cloud mobile 

apps, 233
color combinations, 185–186
fonts, 188
keyboard shortcuts, 44

Welcome screen, 12
white balancing clips, 113–114
white space, 170
Windows, starting Premiere Pro in, 

11–12
workflows, optimizing, 231
workspaces, using, 26–29

going to beginning of, 151
importing, 148
navigating, 72
nesting, 81–83
preparing items for, 134
rough cuts, 41–45
transitions, 53–55

video slide show
creating sequences, 133–139
exporting, 140–143
preproduction, 131
project setup, 132
versions with Media Encoder, 

140–143
video transitions

previewing, 76
setting defaults for, 135–136
using, 53–55

Video/audio track separator, 46
videos. See also final video

adding metadata to, 62
lighting, 114–115
markers for placing photos, 

136–138
sweetening audio, 98–99
trimming, 71–75, 153–155
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